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iS50 GC-IR Module

This section describes the Thermo Scientific iS50 GC-IR module which is an optional 
sampling module for your Nicolet™ iS™50 spectrometer.

Conventions Used in This Document or Help System

This manual uses these conventions for providing safety and other special information:

Contents

• About the GC-IR Module

• Important Features

• Specifications

• Operating Precautions

• Compatible Software

• GC-IR Sampling

• Setting Up the GC-IR System

• Checking Performance

• Samples Compatible with GC-IR

• Your First Experiment

• Maintenance

• Troubleshooting

NOTICE    Be sure that all persons operating this system read the site and safety manual 
first.

WARNING  Indicates a hazardous situation which, if not avoided, could result in death or 
serious injury.
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About the GC-IR Module

The iS50 GC-IR module allows you to combine the separating power of a gas chromatograph 
(GC) with the selectivity of an infrared spectrometer. The GC-IR module is compatible with 
the Nicolet™ iS™50 FT-IR spectrometer and the following gas chromatographs and 
autosamplers:

• Thermo Scientific TRACE™ 1300 series gas chromatographs with autosamplers

• Agilent™ 7890 gas chromatograph

Figure 1. iS50 GC-IR system

Before operating the GC-IR module, you should be familiar with the fundamentals of 
capillary gas chromatography and the operating characteristics of your FT-IR spectrometer 
and GC.

CAUTION  Indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury.

NOTICE    Follow instructions with this label to avoid damaging the system hardware or 
losing data.

Note  Contains helpful supplementary information.

Tip  Provides helpful information that can make a task easier.

The GC-IR module mounts on the right 
side of the Nicolet iS50 spectrometer

Nicolet iS50
FT-IR spectrometer iS50 GC-IR module

Thermo Scientific
TRACE 1310 GC
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A Thermo Scientific TRACE 1310 GC is shown in the illustrations in this document. 
Installation procedures for injectors, detectors and columns are explained in the operating 
guides provided with the GC and will not be reproduced here. For instructions to connect 
your column to the GC-IR module transfer line, see “Setting Up the GC-IR System.”

The iS50 GC-IR module provides these enhanced features:

• Integrated design

• Push button configuration

• High efficiency optics

• Dedicated, highly sensitive detector

• Software-controlled transfer line and flow cell temperature

• Support for GC autosamplers

For information about additional sampling modules and accessories for your Nicolet iS50 
spectrometer, contact our sales representative in your area.

Important Features

This section describes the major features of the iS50 GC-IR module.

From the Front

Figure 2. iS50 GC-IR module front view

These features are visible from the front and sides of the GC-IR module:

• External beam port. Light from the spectrometer passes through this port to the flow cell 
in the GC-IR module. Your iS50 GC-IR module may have an optional KBr window 
installed in the external beam port.

GC-IR Touch Point

External 
beam port

Transfer lineDetector fill port
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• Transfer line. Vaporized sample from the GC passes through this precisely heated line to 
the heated flow cell inside the GC-IR module. The flow cell is where the sample interacts 
with the infrared beam to produce the signal for the GC-IR detector.

• Detector fill port. Used to add liquid nitrogen to the dewar to cool the GC-IR detector 
before each use. For more information, see “Cooling the GC-IR Module Detector.”

• Touch Point. Automatically configures the spectrometer for GC-IR sampling. The Touch 
Point LED shows the status of the GC-IR module. The LED has three states described 
below.

Table 1. GC-IR status indicator states

Back Panel Features

Figure 3. iS50 GC-IR module back panel

LED status Meaning

On Ready for use

Off System is not configured for GC-IR sampling

Blinking Optics are reconfiguring

Purge

Accessory (Detector)
AC power

Power switch
Exhaust vent Computer
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Related Topics

• Connecting a Purge Source

• Cabling the GC-IR Module

• Resetting the Circuit Breaker

• Venting the GC-IR Module Exhaust

• Maintaining the Carbon Filter

Specifications
Table 2. Specifications for the iS50 GC-IR module

Feature Description

Purge Connects to the purge gas supply. For more information, see 
“Connecting a Purge Source.”

Accessory Connector for the detector cable. See “Cabling the GC-IR Module” 
for details.

Computer Connector for the USB communications cable

AC power Connector for the power cord.

Power switch Powers the GC-IR module on and off. A built-in circuit breaker 
automatically shuts off power to the instrument if an over-current 
condition occurs. For information on recovering from an over current 
condition, see “Resetting the Circuit Breaker.”

Exhaust vent Effluent leaving the flow cell travels to a room temperature carbon 
filter and then out this vent. The vent can be routed to a fume hood if 
needed; see “Venting the GC-IR Module Exhaust” for details.

WARNING  Your GC accessory is preset to work with the correct AC line voltage in your 
country. To avoid shock and fire hazard, do not attempt to change the setting. Contact 
our customer support if your system does not meet your local power standards.

Feature Specification

Compatible gas chromatographs • Thermo Scientific TRACE 1300 series

• Agilent 7890

Maximum temperature of
transfer/exhaust lines and flow cell

300 °C

Temperature status output Continuous

Detector Dedicated nitrogen-cooled MCT-A
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Operating Precautions

• Make sure the spectrometer is fully purged before you turn on the GC-IR transfer line 
and flow cell heaters to prevent damage to the KBr windows in the flow cell. For more 
information, choose Help > Spectrometer Help Topics and search for the “Checking the 
Purge” topic.

• To prevent the flow cell windows from becoming contaminated, do not turn on the flow 
cell or transfer line heaters unless a GC column is installed and the helium make-up gas is 
flowing through the flow cell.

• Pieces of graphite, column or dirt in the transfer line or connecting Tee union may enter 
the flow cell and block the infrared beam. Keep the Tee union and transfer line clean and 
free of debris.

• Do not attempt to slide a wide-bore (0.53 mm I.D.) column through the transfer line. 
These columns may become lodged in the Tee union and block the transfer line.

• Avoid spilling excessive amounts of liquid nitrogen on the outer housing of the GC-IR 
detector dewar. Repeatedly cooling the MCT detector window and the seals in the 
vacuum valve can cause the dewar to lose its vacuum.

Compatible Software
Table 3. Software compatible with the GC-IR module

Software Use for...

OMNIC Series Collecting, processing and searching time series data including 
GC-IR, TGA-IR, rapid scan and kinetics data. Includes Mercury GC, 
a dedicated tool for GC-IR analysis (automated profile peak finder 
and multi-component search). For more information, find 
Mercury GC in the Series Help Topics.

OMNIC™ Configuring your GC-IR workflow, including quantitative analysis 
and spectral search, and collecting and analyzing GC-IR spectra. For 
more information, see the “Your First Experiment” section.

OMNIC Specta™ Analyzing unknowns. This software includes our unique 
multi-component search feature for identifying the spectra of 
mixtures, a 9,000 compound spectral database, and features for using 
your computer’s hard drive as a library. For more information, refer to 
the Help system in OMNIC Specta software.

TQ Analyst Creating quantitative and classification methods that can be used with 
OMNIC. This software provides an extensive suite of chemometrics 
features you can use to identify raw materials, perform quantitative 
analysis, and take spectral measurements. For more information, refer 
to the help system in your TQ Analyst software.
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GC-IR Sampling

In a GC-IR experiment the sample is injected into the column of a gas chromatograph which 
separates the sample components. The GC column is routed through a heated glass-lined, 
stainless-steel transfer line to the GC-IR module. Effluent leaving the GC column 
immediately enters the flow cell, where it is scanned by the infrared beam. In effect, the 
infrared spectrometer is a chemically specific detector for the gas chromatograph, sensitive 
only to compounds that absorb infrared radiation.

The flow cell and its fittings are coated with gold, making them inert to materials entering 
from the GC column. Dedicated controllers maintain the temperature of the flow cell and 
transfer line.

When a standard capillary column is used, a make-up gas is added to the transfer line. This 
gas flows around the GC column in the transfer line to prevent backflow. The make-up gas 
also carries the effluent through the larger diameter flow cell with minimal loss of 
chromatographic resolution. The stream exits the flow cell and travels through an exhaust line 
to an unheated carbon filter, which vents out the back of the GC-IR module.

The GC-IR module performs best with standard capillary chromatography columns. 
However, you can also use it with wide-bore capillary columns. In this case, the column is 
connected directly to the transfer line. No make-up gas is required because of the higher flow 
rates used in wide-bore column gas chromatography. For instructions on connecting columns 
to the GC-IR module, see “Setting Up the GC-IR System.”

Related Topics

• Setting Up the GC-IR System

• Setting Flow Cell and Transfer Line Temperature

• Maintaining the Carbon Filter

Setting Up the GC-IR System

After the GC-IR module has been installed by our representative, you are ready to connect a 
purge source and the transfer line, make-up gas line, column and GC detector, if desired. This 
section explains how to connect these items and also describes how to prepare the system for 
running GC-IR experiments.

• Cabling the GC-IR Module

• Connecting a Purge Source

• Connecting the Transfer and Make-up Gas Lines

• Installing a Standard Capillary GC Column

• Installing a Wide-Bore Capillary GC Column
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• Connecting the GC Detector

• Venting the GC-IR Module Exhaust

• Measuring and Adjusting the Make-up Gas Flow Rate

• Cooling the GC-IR Module Detector

• Setting Flow Cell and Transfer Line Temperature

• Recommended Column Flow Rates

Cabling the GC-IR Module

This section describes the electrical, purge and exhaust connections for the iS50 GC-IR 
module.

Table 4. iS50 GC-IR module electrical, purge and exhaust connections

CAUTION  Avoid burn hazard. Do not touch the bare transfer line, flow cell or vent line 
when the insulation has been removed and the heaters are on. Temperatures can exceed 
300 °C (572 °F).

WARNING  Avoid inhaling GC-IR module exhaust. Keep the work area properly 
ventilated or connect the exhaust vent to a fume hood.

WARNING  Avoid explosion hazard. Never use a flammable, combustible, or toxic gas to 
purge this instrument. The purge gas must be free of oil and other reactive materials. Heat 
from the source or from laser absorption may ignite flammable gases or reactive materials 
in purge gas. Use only dried air or nitrogen to purge your instrument.

Connection Description

Purge Connects to the purge gas supply. For more information, see 
“Connecting a Purge Source.”

AC power Plug the AC power cord into this receptacle and then into an AC wall 
outlet.

Detector Plug one end of the detector cable into the Accessory port on the back 
of the GC-IR module. The other end goes to the Accessory port on 
the back of the spectrometer. (The spectrometer has a right and left 
Accessory port. Use the one that is closest to the GC-IR module.)
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Related Topics

• Back Panel Features

• Venting the GC-IR Module Exhaust

• Connecting a Purge Source

Connecting a Purge Source

The GC-IR module must be purged with dry air or nitrogen. The spectrometer window and 
beamsplitter configuration needed for the GC-IR module also require that the spectrometer is 
purged (using only desiccant is insufficient). The purge gas requirements for the GC-IR 
module are the same as for the spectrometer.

We recommend using dry air supplied by a purge gas generator or pure air generator (available 
from us), or nitrogen. Please refer to your Site and Safety Information guide for specific purge 
gas requirements.

Exhaust Connect a length of 1/8 in diameter plastic tubing to the Exhaust port 
on the back of the GC-IR module. Route the other end to a fume 
hood if necessary. For more information, see “Venting the GC-IR 
Module Exhaust.”

Note: You can connect a flow meter to the exhaust vent to measure the 
carrier gas flow rate through the flow cell.

Remote trigger
(optional)

Connect the 37-pin D-type connector of the remote start cable to the 
Auxiliary Signals port on the back of the spectrometer. Connect the 
BNC connector of the cable to the data collection trigger signal for 
your GC. For more information, see the documentation that came 
with your GC.

To set up the remote start cable in OMNIC software:

1. Start OMNIC software.

2. Choose Collect > Experiment Setup, select the Series tab and 
select External Trigger.

Communicationsa This USB cable runs the temperature controllers in the GC-IR 
module. Plug one end of the cable into a USB connector on the 
computer. Connect the other end to the Computer USB port on the 
back of the GC-IR module.

aThe Agilent 7890 GC requires an Ethernet cable instead of a USB cable.

Connection Description
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The purge input connector is on the back of the GC-IR module (see the illustration in “Back 
Panel Features”). For information on how to install the purge equipment, set the controls, and 
inspect and clean the filter, find “Installing a Purge Kit” in Spectrometer Help Topics.

Adjust the GC-IR module purge gas supply pressure and flow rate as described in the table 
below.

We recommend that you leave the purge on at all times. This keeps the GC-IR module free of 
undesirable gases, protects the optics and improves the system’s thermal stability.

Related Topics

• Back Panel Features

Connecting the Transfer and Make-up Gas Lines

The transfer line and the make-up gas line are connected by a stainless-steel Tee union. The 
third opening on the Tee union connects to either the GC column or a splitter if the GC 
column is routed to both the IR detector and the GC detector.

WARNING  Avoid explosion hazard. Never use a flammable, combustible, or toxic gas to 
purge this instrument. The purge gas must be free of oil and other reactive materials. Heat 
from the source or from laser absorption may ignite flammable gases or reactive materials 
in purge gas. Use only dried air or nitrogen to purge your instrument.

NOTICE    Do not use argon as a purge gas. Argon is an insulator and prevents the system 
from cooling properly.

Table 5. Recommended purge pressure and flow rate for the iS50 GC-IR module

Purge Pressure Purge Flow

20 psig 10 SCFH

NOTICE    To protect flow cell windows from contamination, make sure a GC column is 
installed and helium make-up gas is flowing through the flow cell before you turn on the 
flow cell or transfer line heaters.
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Figure 4. iS50 GC-IR module column connections (without the splitter)

This union is used for all capillary GC applications. We connect the Tee union during 
installation. You will need these instructions only if you are converting from wide-bore 
capillary columns to standard capillary columns.

Figure 5. Transfer line and make-up gas line connections

GC injector

Make-up gas 
line

GC Column

Tee union

Transfer line (to GC-IR module)

Larger I.D. cap nut

1/16 in (0.2 cm) O.D. stainless-steel, 
glass-lined transfer line

Graphite ferrule 
(size GFF/16)

Make-up gas 
line

Smaller I.D. cap nut

Graphite ferrule 
(size GFF/16)

Tee union
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 To connect the transfer line and the make-up gas line

1. Locate a Tee union in your GC-IR accessory kit.

You should also find some graphite ferrules. Look at the cap nut on each end of the 
straight-through portion of the Tee union. The nut with the larger internal diameter 
(I.D.) secures the transfer line. The smaller I.D. nut attaches the column (or a splitter if 
one is used). The make-up gas line attaches to the perpendicular stem of the Tee union.

2. Connect the transfer line to the Tee union.

a. Remove the larger I.D. cap nut from the straight-through portion of the Tee union.

b. Slide the cap nut over the transfer line.

c. Carefully slide a size GFF/16 graphite ferrule onto the transfer line, taking care not to 
plug the transfer line with graphite from the ferrule after you slide it over the end.

d. Feed the transfer line through the Tee union until the line stops, and then back out 
the line about 1 mm.

The transfer line should go almost all the way through the union before it stops.

e. Tighten the cap nut finger-tight.

3. Connect the make-up gas line to the Tee union.

a. Remove the cap nut from the perpendicular arm of the Tee union.

b. Slide the cap nut over the make-up gas line.

c. Carefully slide a size GFF/16 graphite ferrule onto the make-up gas line, taking care 
not to plug the line with graphite after you slide the ferrule over the end (use the same 
technique as in step 2 above).

d. Feed the make-up gas line into the Tee union until the line stops and then tighten the 
nut finger-tight.

4. Use a 5/16-in and 1/4-in wrench to tighten the cap nuts for the transfer and make-up gas 
lines.

Turn the nuts about one full turn past finger-tight.

Related Topics

• Installing a Standard Capillary GC Column

• Installing a Wide-Bore Capillary GC Column

• Measuring and Adjusting the Make-up Gas Flow Rate

Tip  If you have a scribe tool with a narrow tapered end, you can slide the ferrule onto 
the scribe and then insert the point of the scribe into the transfer line and slide the 
ferrule off the scribe and onto the transfer line. This technique prevents graphite from 
the ferrule from getting inside the transfer line.
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Installing a Standard Capillary GC Column

This section explains how to install a standard 0.25 mm or 0.32 mm I.D. fused silica capillary 
column into your iS50 GC-IR system. These types of columns connect to the GC injection 
port at one end. The other end must be fed through the Tee union and transfer line and into 
the flow cell of the GC-IR module.

Figure 6. Connections for a standard capillary GC column

 To install a standard (0.25 mm or 0.32 mm I.D.) capillary GC column

1. Attach the column inlet to the injection port on the GC.

Refer to the operating guide that came with your GC for specific instructions.

2. Start the OMNIC software.

You will watch a live interferogram while attaching the other end of the column. This will 
help you determine how far to insert the column into the flow cell.

3. Choose Collect > Experiment Setup and select the Bench tab.

4. On the Bench tab, set Sample Compartment to GC-IR.

Note  If a splitter is used to connect the GC detector, the GC column attaches to the 
GC injection port as described above. The other end of the column attaches to the open 
end of the splitter instead of the Tee union. For details, see “Connecting the GC 
Detector.”

Note  If a splitter is used to connect the GC detector, stop here and follow the 
instructions in “Connecting the GC Detector” to connect the other end of the 
GC column to the splitter.

Transfer line

Tee union

Larger I.D. cap nut

Smaller I.D. cap nut

Standard 
capillary
GC column

Graphite ferrule (size GFF/005 for
0.25 mm and 0.32 mm I.D. columns)
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5. Locate the Tee union that joins the transfer and make-up gas lines. Remove the cap nut 
and ferrule from the free arm of the straight through portion of the Tee union.

6. Thread the free end of your GC column through the cap nut and a ferrule that fits onto 
the column.

7. After you have fed the column through the graphite ferrule, remove 2 to 3 mm from the 
end of the column to create a clean end with no burrs or jagged edges.

To do this, score the column with a tool or scribe intended for this purpose and snap off 
the end piece.

8. While watching the live display at the left side of the Bench tab, carefully feed the column 
through the Tee union and transfer line and into the flow cell.

The live display shows the detector signal. The signal is represented both as an 
interferogram (if the Single Beam check box is cleared) and numerically as minimum and 
maximum voltage values (if the Min/Max check box is selected). Refer to the OMNIC 
Help system if you need more information on Experiment Setup and the live display.

9. When the column enters the flow cell, it will block the infrared beam, causing the height 
of the interferogram in the live display to decrease markedly.

You may have trouble guiding the column through the opening in the end cap of the flow 
cell. Do not force it, as this may damage or break the end of the column. Instead, rotate 
the column gently between your fingers while slowly pushing it further into the transfer 
line.

10. Slowly withdraw just enough column so that the interferogram regains its original height. 

11. Use a 5/16-in wrench and a 1/4-in wrench to tighten the column nut on the Tee union 
until you feel the nut start to offer resistance. Then tighten the nut another one-quarter 
turn.

12. Choose OK to close Experiment Setup.

Related Topics

• Installing a Wide-Bore Capillary GC Column

• Connecting the Transfer and Make-up Gas Lines

• Connecting the GC Detector

NOTICE    Pieces of graphite, column or dirt in the transfer line or Tee union may 
enter the flow cell and block the infrared beam. Keep the Tee union and transfer lines 
clean and free of debris.

Note  If you still cannot get the column to block the beam, just feed in the column as 
far as it will go. Some capillary columns are too large to fit through the end cap.
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Installing a Wide-Bore Capillary GC Column

These columns have an outside diameter that is nearly the same size as the inside diameter of 
the transfer line. To prevent scratching or breakage inside the transfer line, do not try to feed 
these columns into the flow cell as described in the previous section. Instead, thread the end of 
the column through the Tee union and a few millimeters into the transfer line as described 
below. Since the transfer lines are lined with glass, connecting the column this way does not 
adversely affect GC-IR performance.

Figure 7. Connections for a wide-bore capillary GC column

 To install a wide-bore (0.53 mm I.D.) capillary GC column

1. Attach the column inlet to the injection port of the GC.

Refer to the operating guide that came with your GC for specific instructions.

2. Locate the Tee union that joins the transfer and make-up gas lines. Remove the cap nut 
and ferrule from the free arm of the straight-through portion of the Tee union.

3. Thread the free end of your GC column through the cap nut and a ferrule that fits onto 
the column.

4. Remove 2 to 3 mm from the end of the column to create a clean end with no burrs or 
jagged edges.

To do this, score the column with a tool or scribe intended for this purpose and snap off 
the end piece.

Note  If a splitter is used to connect the GC detector, stop here and follow the 
instructions in “Connecting the GC Detector” to connect the other end of the 
GC column to the splitter.

Transfer line

Tee union

Larger I.D. cap nut

Smaller I.D. cap nut

Wide-bore 
capillary
GC column

Graphite ferrule (size GFF/10 
for 0.53 mm I.D. column
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5. Feed the column through the Tee union and a few millimeters into the transfer line.

6. Use a 5/16-in and a 1/4-in wrench to tighten the column nut on the Tee union one-half 
turn past finger-tight.

Related Topics

• Installing a Standard Capillary GC Column

• Connecting the Transfer and Make-up Gas Lines

• Connecting the GC Detector

Connecting the GC Detector

You can connect the GC column to any detector installed on the GC by redirecting a portion 
of the column effluent through a splitter. Although this is not required for GC-IR operation, 
it allows you to monitor the GC chromatography during GC-IR experiments to make sure 
you are getting the expected separation. You may omit this step if desired and connect the 
GC column directly to the Tee union as described in the previous sections.

To connect the column to the GC detector, you will need a 10:1 splitter kit (see our local sales 
or service representative to order the correct splitter). The kit includes a splitter body, extra 
ferrules and two lengths of capillary tubing that are joined at one end by a special ferrule. The 
internal diameter of the slightly darker tubing is 10 times larger than that of the lighter one, 
which produces the 10:1 split ratio. In the package, the smaller diameter tubing is coiled more 
tightly than the larger diameter tubing. Before you remove the coils from the package, make 
sure you mark one of the coils so you can tell them apart during assembly.

The GC column attaches to the short end of the splitter (see the diagram below). The joined 
end of the two lengths of capillary tubing connects to the long end of the splitter. The larger 
diameter tubing from the splitter connects through the Tee union and transfer line to the flow 
cell. The smaller diameter tubing connects to the GC detector.

NOTICE    Pieces of graphite, column or dirt in the transfer line or Tee union may 
enter the flow cell and block the infrared beam. Keep the Tee union and transfer lines 
clean and free of debris.

NOTICE    Do not attempt to feed the wide-bore column through to the flow cell. The 
column may become lodged in the Tee and cause blockage of the transfer line.
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Figure 8. GC detector connection using a 10:1 splitter

 To connect the GC detector

1. Connect the joined end of the splitter tubing to the splitter body.

a. Remove the cap nut from the long end of the splitter body.

b. Thread the free ends of the two lengths of capillary tubing from the splitter through 
the cap nut (the lines are joined by a ferrule so no additional ferrule is needed).

c. Screw the cap nut back onto the splitter body and tighten it with two 1/4-in 
wrenches.

2. Connect the GC column to the splitter.

a. Remove the cap nut from the short end of the splitter body.

b. Thread the free end of your GC column through the cap nut and a ferrule that fits 
onto the column.

c. Remove 2 to 3 mm from the end of the column by scoring it with a column cutter 
and snapping off the end piece. This creates a clean end with no burrs or jagged 
edges.

3. Connect the larger diameter (darker) capillary tubing from the splitter body to the Tee 
union that joins the transfer line and make-up gas line.

a. Remove the cap nut from the free arm of the Tee union.

NOTICE    Pieces of graphite, column or dirt in the splitter, transfer line or Tee 
union may enter the flow cell and block the infrared beam. Keep these connectors 
and lines clean and free of debris.

Graphite ferrule (use appropriate
size for your column)

GC columnCap nut

Smaller diameter (lighter) capillary tubing 
connects to GC detector using new GFF/005 ferrule

Larger diameter (darker) capillary tubing 
connects to Tee union using new GFF/005 ferrule

Cap nut
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b. If there is a ferrule inside the cap nut (from a previous connection), make sure you 
remove the ferrule.

c. Thread the darker capillary tubing from the splitter through the cap nut and then 
add a new graphite ferrule that fits onto the tubing (several GFF/005 ferrules are 
provided in the splitter kit).

d. Remove 2 to 3 mm from the end of the tubing as described above to create a clean 
edge.

e. Follow steps 2 through 12 in the “Installing a Standard Capillary GC Column” 
section to feed the tubing through the transfer line and into the flow cell.

4. Connect the smaller diameter (lighter) capillary tubing from the splitter body to the GC 
detector using a new graphite ferrule from your splitter kit and removing 2 to 3 mm from 
the end of the tubing to create a clean edge.

Follow the instructions in the operation manual for your gas chromatograph.

Related Topics

• Connecting the Transfer and Make-up Gas Lines

• Installing a Standard Capillary GC Column

• Installing a Wide-Bore Capillary GC Column

Venting the GC-IR Module Exhaust

Effluent leaving the flow cell travels through a heated transfer line to a room temperature 
carbon filter and then to the exhaust vent. The carbon filter absorbs the GC components in 
the effluent before they reach the vent.

 To connect an exhaust line to the GC-IR module

1. Connect a length of 1/8-in diameter plastic tubing to the exhaust vent on the back of the 
GC-IR module.

The other end can be routed to a room vent or fume hood if necessary.

Related Topics

• Back Panel Features

• Maintaining the Carbon Filter

WARNING  Avoid inhaling GC-IR module exhaust. Keep the work area properly 
ventilated or connect the exhaust vent to a fume hood.
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Measuring and Adjusting the Make-up Gas Flow Rate

Skip this section if you are using a wide-bore (0.53 mm) capillary GC column, since those 
columns do not require make-up gas. Before continuing, make sure that the valve from the 
make-up gas source is closed by turning the knob fully clockwise.

If you are using a standard (0.25 mm or 0.32 mm I.D.) capillary column, you need to supply 
enough make-up gas to purge the transfer line around the capillary column. This requires a 
flow rate of only 0.3 to 0.5 mL/min. Higher make-up gas flow rates improve 
chromatographic flow through the flow cell but also dilute the sample, causing the IR 
sensitivity to decrease. Flow rates greater than 1.5 mL/min do not further improve 
chromatographic peak shapes.

 To measure and adjust the make-up gas flow rate

1. Locate the make-up gas supply valve.

For the TRACE 1310 GC, the valve is installed on the top of the GC under the hinged 
cover for the rear detector module.

2. Open the flow cell make-up gas supply valve by turning the knurled knob 
counterclockwise as far as it will go.

Figure 9. Make-up gas supply valve

3. Turn off the GC detector gas flow.

4. Attach the flow meter tube to the exhaust vent on the back of the GC-IR module.

5. Measure and record the total flow rate.

This is the column flow rate plus the make-up gas flow rate.

6. Turn off the GC column flow.

You can do this either by setting the column flow rate to zero (if your GC has an 
electronic flow control) or by reducing the column head pressure until the column flow 
reaches zero.

7. Measure the flow rate again.

Make-up gas supply valve

Knurled knob
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This is the make-up gas flow rate.

8. Adjust the make-up gas valve so that the make-up gas flow rate is between 0.3 and 
0.5 mL/min.

To adjust the valve, turn the slotted adjustment screw inside the knurled knob 
counterclockwise to increase the flow or clockwise to decrease the flow.

Figure 10. Make-up gas flow rate adjustment screw

Related Topics

• Connecting the Transfer and Make-up Gas Lines

Cooling the GC-IR Module Detector

GC-IR applications require a highly sensitive mercury-cadmium telluride (MCT) detector. 
This detector is sensitive to infrared radiation between 5000 cm-1 and 600 cm-1.

An MCT detector must be cooled with liquid nitrogen before you collect data. The detector 
dewar is located under the dewar cover on the GC-IR module.

Note  The outer knurled knob is not used for adjustment; it is used only for turning 
the flow on or off. Make sure the outer knob is in the full counterclockwise (open) 
position before you adjust the inner flow control screw.

Adjustment screw

Knurled knob (top view)
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Figure 11. GC-IR Module detector dewar cover

Equipment needed:

• small plastic laboratory funnel

• one-quart, glass lined or stainless-steel lined laboratory vacuum bottle

• a supply of liquid nitrogen

 To cool the GC-IR module detector

1. Open the detector dewar cover and remove the plastic stopper.

2. Insert a funnel into the liquid nitrogen fill port of the detector dewar. 

3. Slowly fill the detector dewar with liquid nitrogen through the funnel.

Cool the funnel and funnel stem first: fill the funnel and let it drain completely into the 
detector two or three times. Always let the liquid nitrogen flow into the detector before 
adding more liquid nitrogen. 

Dewar cover

WARNING  Avoid freeze burns. Liquid nitrogen is extremely cold and therefore potentially 
hazardous.

• Wear protective equipment and follow standard laboratory safety practices.

• To avoid hazardous contact with liquid nitrogen, make sure any dewar or container 
used to hold liquid nitrogen can do so safely without breaking.

• When filling the dewar, be careful not to contact the liquid nitrogen with your skin. 
Fill the dewar slowly. Cooling the detector too quickly may cause the dewar to rapidly 
boil off liquid nitrogen.
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A small amount of liquid nitrogen spillage will not harm the instrument, but do not 
overfill the detector or pour too quickly. Cooling the detector too quickly may cause the 
dewar to rapidly boil off or spill out excess amounts of liquid nitrogen.

When the detector is nearly full, a small amount of liquid nitrogen will boil off. 
Approximately one liter of liquid nitrogen will be consumed in this process.

4. Let the vapor plume dissipate, replace the plastic stopper, and close the dewar cover. 

Allow at least 20 minutes for the detector to cool before use.

Setting Flow Cell and Transfer Line Temperature

Two software-driven controllers located inside the GC-IR module heat the flow cell and 
transfer line. The temperature of the flow cell and transfer line should be stable before you 
start collecting data.

 To set the flow cell and transfer line temperature

1. Make sure a GC column is connected to the GC-IR module and the helium make-up gas 
is flowing through the flow cell. For more information, see “Measuring and Adjusting the 
Make-up Gas Flow Rate.”

2. Turn on the power switch for the GC-IR module.

3. Press the Touch Point on the top of the GC-IR Module.

NOTICE    Do not spill liquid nitrogen onto or near the detector window. Rapid 
cooling of the window’s o-ring seal can cause the dewar to lose vacuum. Prolonged 
exposure to atmospheric pressure can damage the detector element. Always fill the 
dewar with the instrument cover in place.

Table 6. Flow cell and transfer line recommended temperature

Normal Operating Rangea

aWe generally recommend a flow cell and transfer line temperature 10 C° hotter than the maximum GC oven 
temperature program setting being used for the run. Infrared throughput, and therefore sensitivity, decreases with 
temperature, so do not set the controllers unnecessarily high.

Acceptable Operating Range

200 to 280 °C 30 to 300 °C

NOTICE    

• To prevent the flow cell windows from becoming contaminated, do not turn on the 
flow cell or transfer line heaters unless a GC column is installed and the helium 
make-up gas is flowing through the flow cell.

• Do not attempt to set the GC-IR temperature controllers manually or you may affect 
proper operation of the GC-IR module.
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4. Open OMNIC software.

5. Choose Series > Heater Status.

A dialog box is displayed.

Figure 12. Heater Status dialog box in OMNIC software

6. Select Heaters On.

7. Enter a value between 30 and 300 °C for each heater and then choose Update Heaters.

The table below describes the functions of the status indicators:

Table 7. Heater Status LED status and failure modes

Heater status icons

Setpoint temperature Current temperature

Resets heaters to new 
setpoint temperatures

Turns heaters on and off

Heater status readouts
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Related Topics

• Cabling the GC-IR Module

Recommended Column Flow Rates

GC-IR sensitivity is best when your sample elutes with sharp, narrow peaks. This level of 
performance is usually obtained by operating your chromatograph in its optimum efficiency 
range. For best results with the GC-IR application, use these recommended flow rates.

Indicator Function

Heater status LED states are:

• Gray - GC-IR module is powered off or the USB 
communications cable is not connected (GC-IR module 
to computer)

• Yellow - Heating

• Green - At setpoint temperature

• Red - Failed (a message describes the error)

Possible failure errors • Flow cell/transfer line input failure

• Flow cell/transfer line data failure

• Flow cell/transfer line heater failure

• Flow cell/transfer line over temperature failure

If an error condition occurs, turn off the GC-IR module 
power switch, wait 1 minute and then turn the power switch 
back on. If that doesn’t correct the problem, call our local 
service representative.

CAUTION  Avoid burn hazard. If the temperature indicator is red and an “over 
temperature failure” message appears, turn off the GC-IR module power switch and do 
not touch the transfer line, flow cell or vent line. Contact us for assistance.

Note  After the heaters have reached the specified operating temperature, they will remain 
at that temperature until you clear the Heaters On option in Heater Status or turn off the 
power to the GC-IR module.
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Related Topics

• Installing a Standard Capillary GC Column

• Installing a Wide-Bore Capillary GC Column

• Measuring and Adjusting the Make-up Gas Flow Rate

Checking Performance

You should periodically check the performance of the GC-IR module by using the Bench 
Diagnostics software. Keep a log of the date each test is run and the test result. You should also 
record the flow cell temperature, the number of scans and the resolution.

 To run the performance test

1. Open OMNIC software.

2. Choose Collect > Advanced Diagnostics.

3. Choose Performance Test.

The Nicolet iS50 Diagnostics window lists the available performance tests.

Figure 13. Nicolet iS50 Diagnostics window

Table 8. Recommended flow rates for capillary GC columns

Column type Flow rate (mL/min)

Standard
(0.25 to 0.32 mm I.D.)

1 to 3

Wide-bore
(0.53 mm I.D. or greater)

2 to 3
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4. Select GC - MCT/A.

5. Make sure the check boxes for all the other tests are cleared.

6. Choose Run Selected Test.

The software collects a few background and sample scans to generate a 100% line 
spectrum and calculates the spectrum’s signal to noise ratio. The numerical result is added 
to the Actual column in the diagnostics window and a Pass or Fail result appears in the 
Status column. If the Actual noise value is less than the Expected (or maximum allowable) 
value, the test will report a pass result.

7. Close the Bench Diagnostics window.

Related Topics

• Troubleshooting

Samples Compatible with GC-IR

Any sample that can be measured by gas chromatography will work with the GC-IR 
application. GC-IR is especially useful for differentiating configurational stereoisomers such 
as diastereomers and enantiomers.

Your First Experiment

This section explains how to configure your GC-IR workflow and demonstrates how to use 
the GC-IR system to analyze a sample. These topics are covered:

• Configuring Your GC-IR Workflow

• Preparing the GC-IR System for Sampling

• Measuring a Sample by GC-IR

Configuring Your GC-IR Workflow

The GC-IR Touch Point has an associated user-configurable workflow that can define 
everything from background and sample collection to quantitative analysis and spectral 
search. You simply press the Touch Point to start the workflow.

 To configure your GC-IR workflow

1. Start OMNIC software.

The OMNIC window is displayed. For information about the OMNIC window, choose 
Help > OMNIC Help Topics.

Note  If the GC-IR module fails the performance test, consult the Troubleshooting 
information or contact our local service representative for assistance.



 iS50 GC-IR Module

Thermo Scientific iS50 GC-IR Module User Guide 27

2. Choose the GC-IR Touch Point button in the software to configure the instrument for 
GC-IR sampling.

Figure 14. GC-IR Touch Point buttons

3. Choose the Touch Point Setup button in the software.

A dialog box is displayed.

Figure 15. Touch Point Setup for iS50 GC-IR module

Notice that Sample Compartment (upper left pane) is set to GC, and below that pane is a 
list of iS50 experiments for the GC-IR module. The selected experiment is highlighted 
and its associated settings are visible in the dialog box.

The Touch Point dialog box provides commonly used settings that define how your 
GC-IR data will be collected, displayed, measured and reported. Brief descriptions are 
provided below.

Touch Point Setup button

GC-IR Touch Point button
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Table 9. iS50 GC-IR Touch Point settings

Option Description

Measurement time Determines the duration of scanning for each collected 
spectrum.

Number of scans Shows the scans collected for the selected measurement time. 
Multiple scans are averaged.

Resolution Sets the spectral resolution of the data you collect. Typically 
8 cm-1 or 4 cm-1 is a good starting point for most GC-IR 
applications. The smaller the resolution value, the higher 
(better) is the resolution. The resolution value, along with the 
measurement time, affects the number of scans.

Final format Determines the Y-axis unit used for the collected data. 
Typically set to Absorbance for GC-IR applications.

Preview data 
collection

Select this option if you want to collect and view (but not save) 
preliminary data before the start of a sample or background 
data collection. This lets you verify that your experimental 
conditions are correct before you start collecting GC-IR data. 
This option is typically off for GC-IR applications since the 
start of data collection is usually coordinated with the injection 
time.

Region Determines the spectral range of the spectrometer that will be 
used to collect the data. The spectral range is defined by the 
type of source, beamsplitter and detector used. Mid-IR is the 
only available Region option for the GC-IR module.

Max/min Shows the default limits of the GC-IR detector’s spectral range. 
The Max/Min limits can be reduced to eliminate spectral 
regions that provide no additional information about the 
sample.

Background handling Lets you specify when to collect a background spectrum to be 
used for ratioing sample spectra you collect. Collecting a 
background after a specified number of minutes is a good 
choice for many applications. You will be prompted to collect a 
background the very first time you collect sample data.
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Analyze Measured 
Sample

Allows you to select and run analyses on a collected sample 
spectrum. The analysis results are attached to the spectrum 
and saved in the spectral (.spa or .spg) file.

Note: These settings apply only to single spectra collected as an 
.spa or .spg file. The settings are available for GC-IR 
applications but not typically used since most GC-IR 
experiments collect a series of spectra over a period of time and 
save them in a series (.srs) file.

The following analyses are available:

• Quantify. Finds the concentrations of components in a 
sample spectrum. For more information, find 
“Quantifying a Spectrum” in OMNIC Help Topics.

To select the quantitative analysis method you want to use 
to quantify a spectrum, choose Analyze > Quant Setup.

• Search. Identifies an unknown material by comparing the 
unknown sample spectrum with each reference spectrum 
in the selected libraries to find the spectra that most closely 
match the unknown. For more information, find 
“Searching a Spectral Library” in OMNIC Help Topics.

Use Analyze > Library Setup to select the reference 
libraries to be searched.

• QCheck. Compares spectra to determine their degree of 
similarity, expressed as a correlation value from 0.0 (no 
similarity) to 1.0 (the spectra are identical). For more 
information, find “Comparing Spectra with QCheck” in 
OMNIC Help Topics.

Use Analyze > QCheck Setup to set up the comparison.

• Find Peaks. Identifies peak locations in a spectrum by 
finding peaks whose Y values exceed a specified threshold 
value. The peaks are labeled with their X values. For more 
information, locate “Finding Peaks Above a Specified 
Height” in OMNIC Help Topics.

• Threshold. The Y value above which peaks can be 
found.

• Sensitivity. Determines how readily shoulders on 
peaks and small peaks in the baseline will be found.

Table 9. iS50 GC-IR Touch Point settings

Option Description
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4. Select an appropriate experiment in the “Experiments Using: GC” pane.

5. Set the Touch Point Setup options as desired.

6. If you want to overwrite the default settings without overwriting the default experiment, 
choose Set Default.

7. Choose Save.

8. Choose Experiment Setup at the bottom of Touch Point Setup.

9. In Experiment Setup, select the Series tab.

Auto Report Can be used to automatically display, print or save an auto 
report of the analysis results. For more information, find 
“Working with Auto Reports” in OMNIC Help Topics.

Note: These settings apply only to single spectra collected as an 
.spa or .spg file. The settings are available for GC-IR 
applications but not typically used since most GC-IR 
experiments collect a series of spectra over a period of time and 
save them in a series (.srs) file.

The following options are available:

• Preview. Displays the auto report after the analysis is 
completed.

• Print. Prints the auto report after the analysis is 
completed.

• Add to current notebook. Adds the report to the current 
notebook. For more information, find “Adding a Report 
to a Notebook” in OMNIC Help Topics.

Default experiment Shows the file name of the default experiment for the selected 
sample location.

Table 9. iS50 GC-IR Touch Point settings

Option Description
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Figure 16. Series tab in Experiment Setup

10. In the Profiles box, select Gram-Schmidt to create a Gram-Schmidt profile from the 
collected data.

11. To see the options available for the Gram-Schmidt profile, choose Edit below the Profiles 
box. For more information, choose a Help button in the software.

12. Choose Edit below the Time Sequence box and set Segment Type to Save and Save Time 
to match the total collection time for the GC and choose OK. This will save all the data 
collected during your GC run.

13. Choose Save at the bottom of Experiment Setup and then choose OK.

For an introduction to Series data collection including setting up profiles and time 
segments, refer to your Series Getting Started guide. For details about the features on the 
Series tab, open Series Help Topics from the OMNIC Help menu. For information about 
features on other tabs in Experiment Setup, choose Help from Experiment Setup.

Related Topics

• Preparing the GC-IR System for Sampling

Note  Some settings appear in Experiment Setup and Touch Point Setup. Setting these 
options in one location automatically changes them in the other.

Select the Gram-Schmidt profile

Choose Edit to set Gram-Schmidt profile options

Choose Edit to set Time Sequence options
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• Measuring a Sample by GC-IR

Preparing the GC-IR System for Sampling

Follow the steps in this section to prepare the GC-IR system and measure a sample.

 To prepare the GC-IR system

1. Power on the spectrometer and allow the instrument to stabilize for at least an hour (if the 
instrument has been powered off for more than 20 minutes).

2. Power on the GC-IR module.

3. Open OMNIC software.

4. Press the GC-IR Touch Point to configure the instrument optics for GC-IR sampling and 
load the associated workflow.

5. Choose the Touch Point Setup button in the software and adjust the Touch Point Setup 
and Experiment Setup settings as needed. See “Configuring Your GC-IR Workflow” for 
more information.

6. Power on the GC and set the oven temperature. Refer to the operating manual that came 
with your GC for more information.

7. Set the make-up gas pressure and flow; see “Measuring and Adjusting the Make-up Gas 
Flow Rate” for more information.

8. In OMNIC software, choose Series > Heater Status. Turn on Heater and enter a setpoint 
temperature for the GC-IR transfer line and flow cell (should be 10 °C hotter than the 
maximum temperature for the GC oven). For more information, see “Setting Flow Cell 
and Transfer Line Temperature.”

9. Wait for the spectrometer and heaters to stabilize.

Related Topics

• Measuring and Adjusting the Make-up Gas Flow Rate

• Setting Flow Cell and Transfer Line Temperature

• Configuring Your GC-IR Workflow

NOTICE    To prevent the flow cell windows from becoming contaminated, make sure 
make-up gas is flowing through the flow cell before you turn on the flow cell and 
transfer line heaters.

CAUTION  Avoid burn hazard. If the temperature indicator is red and an “over 
temperature failure” message appears, turn off the GC-IR module power switch and do 
not touch the transfer line, flow cell or vent line. Contact us for assistance.
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• Measuring a Sample by GC-IR

Measuring a Sample by GC-IR

Before you begin

Have your sample material at hand. For this first experiment, we recommend that you choose 
a known material that produces a GC spectrum with distinct, sharp peaks.

Figure 17. GC-IR system ready for sampling

 To measure a sample with your GC-IR system

1. Follow the steps in “Preparing the GC-IR System for Sampling.”

2. If your GC-IR workflow is not configured, follow the steps in “Configuring Your GC-IR 
Workflow” to configure it.

3. Choose Collect > Collect Series.

If no infrared background spectrum is available, a message asks you to prepare for the 
background collection. The background serves as a reference to compare with the sample 
data that is collected over time.

4. Choose OK to start collecting a background spectrum.

When the background collection is completed, another message asks you to prepare to 
collect a set of basis vectors which are used to calculate the Gram-Schmidt profile.

5. Choose OK to start collecting the basis vectors.

The Collect Series Basis Vectors window appears showing the progress of the collection. 
When data collection is finished, the Save Group box appears.

6. Specify a file name and directory location and choose OK.

Touch Point
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After the basis vectors have been collected, another message tells you to choose OK when 
you are ready to begin sample data collection.

7. Inject a sample into the GC and start the GC run.

8. Choose OK in the GC-IR system software (or press the space bar on the computer 
keyboard) to start GC-IR data collection.

As the experiment proceeds, the Gram-Schmidt profile gradually appears, left to right, in 
a time response display. The Gram-Schmidt profile is a plot showing how overall spectral 
intensity changed during the experiment. In the GC-IR example below, the peaks in the 
Gram-Schmidt plot indicate when different compounds in the sample eluted from the 
GC column, passed through the spectrometer beam path and absorbed infrared energy.

Figure 18. Gram-Schmidt reconstruction

The spectrum currently being collected appears in the spectral data display.

Note  If you are using an external trigger, GC-IR data collection will start 
automatically when you start the GC run. For more information, refer to the 
document that came with the external trigger cable.

Spectral intensity axis Time axisPeaks

Time response display

Spectral data display
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9. To display a spectrum collected at a particular time, first select the spectral cursor tool...

…and then click the desired time location in the profile in the time response display. 

Here is an example showing the cursor located at the top of a peak in the time response 
display and the corresponding spectrum in the spectral data display.

Figure 19. Using the spectral cursor tool to display the spectrum collected at a specific time in 
the series data

Note  If you don’t see spectral features in this window, inject a sample that is at a 
higher concentration (2 to 10 times higher than the previous one) and collect the data 
again. If you are using a split injection technique, you can also decrease the split ratio 
so a higher concentration of the sample goes onto the GC column. For example, if 
you were using a 100:1 split ratio, try changing it to 20:1.

Note  To return to a “live” display that shows the spectrum currently being collected, 
click the Live button.

Spectral cursor

Spectrum collected at specified time
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When the series experiment is completed, the collected data appears in a series profile 
window.

10. If you want to search the selected GC-IR spectrum, choose Series > Mercury GC > 
GC Setup. In the Mercury GC Setup box, select a vapor phase library that contains 
compounds that are similar to your sample material.

11. Choose GC Identify to perform the search. For more information about Mercury GC 
features, choose the Help button in the Mercury GC results window.

Figure 20. Mercury GC search results

12. If you are finished analyzing GC-IR samples, lower the flow cell and transfer line heater 
settings to 125 °C (257 °F) but leave the make-up gas flow on.

If you don’t plan to use the GC-IR module for an extended period, lower the flow cell and 
transfer line heater settings as described above. When the flow cell and transfer lines have 
cooled to room temperature, turn off the make-up gas flow and then turn off the power 
switch on the GC-IR module. There should still be purge gas flowing through the GC-IR 
module.

Related Topics

• Connecting a Purge Source

• Setting Flow Cell and Transfer Line Temperature
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• Configuring Your GC-IR Workflow

• Preparing the GC-IR System for Sampling

Maintenance

This section covers these topics:

• Resetting the Circuit Breaker

• Maintaining the Carbon Filter

Resetting the Circuit Breaker

If the GC-IR module power indicator does not light when you turn on the power switch, the 
circuit breaker may need to be reset. This may occur after a ground fault or a short in the 
power line.

 To reset the breaker switch

1. Turn off the GC-IR module power by pressing the power switch on the back panel.

2. Wait 1 to 3 minutes and then turn the power switch back on.

If the power indicator still does not light, contact our service representative in your area.

Related Topics

• Troubleshooting

Maintaining the Carbon Filter

The carbon filter does not require maintenance or replacement. It is expected to last the 
lifetime of your instrument.

Troubleshooting

This section explains how to troubleshoot problems with the GC-IR system. These topics are 
covered.

• Chromatographic Hardware Problems

• Spectrometer or GC-IR Module Hardware Problems

• Other Problems

CAUTION  Avoid burn hazard. Do not touch the bare transfer line, flow cell or vent line 
when the insulation has been removed and the heaters are on. Temperatures can exceed 
300 °C (572 °F).
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Chromatographic Hardware Problems

The best way to determine if there is a problem with the GC hardware is to look at the same 
data from the GC detector. If your GC-IR module has the 10:1 splitter (see “Connecting the 
GC Detector”), the GC detector is already connected. If your GC-IR module does not have a 
splitter, disconnect the GC column from the GC-IR module and connect it directly to the 
GC detector. The GC can then be used by itself.

Run your sample on the GC and check to see if the separation and results are what you 
expect. If the problem persists when the GC is used by itself, refer to the troubleshooting 
section of the GC reference manual. If the GC results look normal, you can assume the 
problem is not with the GC hardware. See “Spectrometer or GC-IR Module Hardware 
Problems” for more information.

Related Topics

• Connecting the GC Detector

• Spectrometer or GC-IR Module Hardware Problems

Spectrometer or GC-IR Module Hardware Problems

These problems fall into two categories:

• Low infrared throughput

• Chromatographic problems within the GC-IR module.

Low infrared throughput can be recognized if you keep a record of the peak-to-peak 
interferogram voltage, a single-beam spectrum, the results of the Performance Test (from the 
Bench Diagnostic program), and a 100% line. You should record the flow cell temperature, 
the number of scans and the resolution. By keeping this information, you can monitor the 
system integrity over time.

Causes of low infrared throughput may involve:

• Alignment of the beamsplitter or flow cell

• Contamination of the flow cell or flow cell windows

• Failed IR components, including the source and detector (if not properly cooled). A quick 
check of the signal from the detector in the main spectrometer will check most of the 
FT-IR system components.

You can recognize chromatographic problems within the GC-IR module if you first run your 
GC without the GC-IR module connected (see “Chromatographic Hardware Problems”). If 
the GC appears to be operating correctly as a stand-alone instrument, check the transfer lines 
and flow cell. Sources of leaks or blockages may include:

• Transfer lines. Ferrules may be unseated, or graphite or other contaminants may be 
blocking the lines.
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• Flow cell. Flow cell windows may be cracked, end cap seals may be unseated, or an end 
cap may be plugged.

You can isolate leaks in the system by holding an opened but not lit butane lighter in each of 
the suspected problem areas while flowing carrier gas through the flow cell and into the FID 
(Flame Ionization Detector). If you used a splitter to connect the GC detector, monitor the 
FID signal on the GC. The presence of an FID peak for butane means a leak exists.

You can find plugged lines if no infrared signal changes are detected for an injection of a 
low-boiling solvent (for example, CH2Cl2). Monitor this in the GC scan mode.

Related Topics

• Connecting the GC Detector

• Chromatographic Hardware Problems

Other Problems

Heater Status not available in software

If you don’t see the Heater Status item in the Series menu of OMNIC software, make sure the 
GC beam path is selected. To do this, either press the Touch Point button on the top of the 
GC-IR module or choose Collect > Experiment Setup, select the Bench tab and set Sample 
Compartment to GC.
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